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INTRODUCTION

EVERYTHING YOU NEED TO KNOW ABOUT PST FILES

WHAT ARE PST FILES?
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Microsoft Outlook is one of the most popular email clients for business communication. Besides its simple, utilitarian 

interface, there are several other reasons for the popularity of Outlook. A key reason is the way it stores the data and 

enables access to stored emails, even when a user is not connected to the Internet. The data associated with individual 

email accounts—emails, calendars, tasks, and contacts— are stored in data files as Personal Storage Table (PST) and Offline 

Storage Table (OST).

When an email account is added to Outlook, a local copy of this information is stored on the computer in which it is created. 

The local copy ensures that the user has access to synchronized email messages, calendars, tasks, and contacts even without 

an Internet connection. This information is stored as PST or Personal storage Table file. 

PST files are not just for POP3 accounts, but can also be used by IMAP for archiving purposes. In fact, it’s highly recommended 

to store non-email information such as Contacts and Calendar inside a PST file, especially while using IMAP accounts. 

HISTORY OF PST FILES

The PST file format was first launched/published in 1996, and was so named to distinguish it from the Offline Storage Table or 

OST file format that was introduced along with Microsoft Exchange. 

PST files became popular early on because of slow Internet speeds in those times and the relatively small size of online storage 

that was assigned to each user.

Though more advanced formats have emerged over the years, PST files continue to be used for a host of reasons. 

The most important reason is that PST files not just store data, but are also used to backup or export items from any type of 

email account. In addition, the files saved in this format are not subject to the mailbox size limits that apply on a mail server, 

which means that emails can be moved to PST files to free up space on the mail server. This flexibility explains the widespread 

use of PST files. 

WHERE TO FIND THE PST FILE IN A COMPUTER?

By default, Outlook PST files are located at C:\Users\AppData\Local\MicrosoftOutlook in Windows 10, 8, 7, and Vista systems, 

and at C:\Documents and Settings\Local Settings\Application Data\Microsoft Outlook in Windows XP.

You can also go to File -> Data File Management in Outlook 2007 and previous versions, and File ->Account Settings and Data 

Files tab in Outlook 2010, Outlook 2013, Outlook 2016 and Outlook 2019 to get information about your data files.
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WHY TO USE PST FILES?
PST files are simple and easy to use. They are ideal for backup and restore, and can also make it easy to manage emails. Here 

are some reasons why users should use PST File:

Source: Howto-outlook.com

While searching for PST files, it is important to include hidden system files and folders in the scope of search.

1.  OFFLINE ACCESS
       When you have the email contents stored in a PST file, you don't always need to have an Internet connection to view the

       downloaded and synced messages. This way, you can have access to all your content offline. This can be particularly

       helpful if you're in a place that has poor Internet connectivity and also during Internet outages and power failures. 
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CAUSES OF PST FILE CORRUPTION

Before going into how you can fix corrupt PSTs, here are some common causes of PST file corruption.

PST FILE CORRUPTION – A KEY CHALLENGE
Despite widespread use of PSTs and several advantages – as presented in the preceding sections– there are a few challenges 

too. PST file corruption is one such challenge, which hampers user access to Outlook and often leads to Outlook client crash, 

with the following error: 

AppName: Outlook.exe 

AppVer: 14.0.4760.1000

ModName: Kernelbase.dll

ModVer: 6.1.7600.16385

Offset: 0003194b

This error means that your PST file is corrupted, and you'll need to fix this first, before the users can start using their Outlook 

again. During this time, productivity goes down and users may not even be able to respond to urgent emails. All this might 

eventually lead to substantial business loss, which is another reason to fix PST file corruption errors right away.

2.  PORTABILITY
       Moving your PST files from one location to another is a simple. All you have to do is copy the PST file in a removable

       storage or in any other location you want, and all your email contents are transferred easily. 

3.  EASY BACKUP
       Backing up the PST file is fairly easy. All you have to do is copy the file and paste it on another location. This location

       could be a hard drive, an online cloud storage, an external hard drive, a USB memory stick, CD/DVD, a flash memory

       card, etc. It's really that simple. 

4.  EASY RESTORATION 
        To restore the PST file, simply copy the file from the external location back to your Outlook folder. Next, open Outlook

        and connect the PST file by navigating to File ->Open ->Outlook Data File.

5.  ACCESSIBLE WITHOUT OUTLOOK
       You don't necessarily need Outlook to view PST files. There are many tools available today which can be used to browse

       the contents of a PST file. This feature is particularly useful when you want to view PST files on a device that doesn't

       have Outlook installed in it.

6.  SECURITY
       PST files allow you to restrict access to the content, which helps add an extra layer of security to the data. You can even

       add some extra security to your hard drive to ensure that no one else, except you, can access your PST files.
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1.  ANSI-FORMATTED PST FILES
      If a PST file is around 2GB and Outlook is unable to open that file, it means that it’s an ANSI-formatted PST file. This was the

     only format available in Outlook 2002/XP and has a file size limit of 2GB. In fact, once you reach the hot fix limit of 1.82GB, it

     prevents users from adding any more data. 

     Microsoft Outlook 2003 and later versions have PST files in Unicode format. Some versions of Microsoft Outlook place size

     restrictions on these formats too, which means, there is a possibility of corruption in these versions as well. So, an ANSI-

     formatted PST file that is larger than 1.82 GB in size can get corrupted. This will lead to problems while accessing mailbox

     folders and email messages. 

     The following are some of the errors that Outlook will throw if a PST file is larger than 1.82GB.

          •    Synchronization errors, especially while syncing mailboxes from two different Outlook versions.

          •    File access errors

          •    Errors while sending or receiving emails. 

     One way to fix this problem is to convert the ANSI file to Unicode format, provided you can open the file in Outlook. 

     Otherwise, the only option is to use third party tools to repair corrupt PST Files.

2.  CYCLIC REDUNDANCY CHECK ERRORS
       A Cyclic Redundancy Check (CRC) error while copying a PST file or while trying to open it in Outlook means that your hard

       drive is going to crash any time soon. And you need to look into it right away, as this may lead to corruption in Outlook 

       PST File.

3.  HARDWARE FAILURE
      Storage device failure, network failure, and power failure can cause a PST file to get corrupted. When PST files are caught 

      in the bad sectors of a hard drive, the chances of corruption are fairly high. In addition, power failures can corrupt a PST file

      especially while in use.

4.  SOFTWARE ISSUES
       Software failures such as problems in Outlook, improper recovery procedures, and abrupt shutdown can corrupt PST files. 

       Out of these issues, the most common is wrong system recovery caused due to overwriting with garbage data and incorrect

       alignment of data blocks during a faulty recovery process.

5.  VIRUS/MALWARE ATTACKS
      Virus and other malicious forms of attacks can corrupt the PST file. Some viruses that have corrupted the PST files in the 

      past are Melissa, BleBla, Stages virus and worm explore zip. In most cases, these virus programs turn the PST file inaccessible.

6.  IMPROPER SHUTDOWN
       The general process is to shutdown Outlook after saving all the changes made to the PST file. If the task manager is used to

       close Outlook or if there was an accidental shutdown, PST files tend to get corrupted.
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When the PST file is corrupt or damaged, Outlook will give a message that it can't be opened. In such a case, you can run the 

built-in Inbox Repair Tool called scanpst.exe.

One of the first tools used by most IT administrators to fix a corrupted PST file is the inbuilt utility provided by Microsoft i.e. 

Inbox Repair Tool called Scanpst.exe. 

Other possible errors may include, "Errors have been detected in the file <pst file path>" and "The file <pst file path> is not an 

Outlook data file."

Sometimes, this tool is also run when 

     •    To fix Microsoft Outlook crashes

     •    To fix mspst.dll errors in Event Viewer

     •    Unable to complete import or export

     •    Errors in send or receive process

     •    Non-maintenance of view settings

In any of these situations, running the scanpst.exe program could fix the problems. It is also recommended to run scanpst.exe 

in the following scenarios.

     •    Outlook or computer crash - If the computer crashes when Outlook is writing data to the PST files, it is the best to run

           scanpst.exe

     •    Outlook not closed properly - If the Outlook process was running during the system shutdown, it is equivalent to a

          crash. Here too, it is a good idea to run scanpast.exe.
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     •    Add-ins - Not all add-ins are ideal to extend the functionality of Outlook. If there are problems in Outlook or if the PST

          files are corrupted, review the installed add-ins. Disable each add-in individually to note any improvements in the

          performance and identify the problematic one.

     •    Network share - Storing PST files on a network share is not supported by Microsoft, so it could lead to corruption in PST

          file and even data loss.

     •    Outlook errors while opening - When Outlook throws errors like the one below when you try to open it. 

Source: Howto-outlook.com

Apart from these, there are many other cases where you can use scanpst.exe to fix Outlook error. Though there is no guaran-

tee that it will fix all types of errors especially severe cases of corruption.

PST FILE REPAIR PROCESS - SCANPST.EXE
The repair process is comprised of the following steps:

     1.   LOCATE AND RUN THE PST FILE
           As soon as scanpst.exe file is run, it prompts for the location of the PST file that needs to be scanned. These PST files are

           stored in the default locations, as mentioned in earlier sections. Select the PST file that needs to be repaired and click the

           "Start" button.
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     2.   SCANNING PROCESS
           Once you press the "Start" button, scanpst.exe will do an analysis first. This process also consists of eight phases and

           could take some time, depending on PST file size and the severity of corruption.

           After scanning is complete, scanpst.exe will present a report, along with options on what can be done. Click the "Details"

           button to know more about the corruption.

 Location of scanpst.exe for each version of Microsoft Outlook 

 Outlook 2002/XP - C:\Program Files\Common Files\System\MAPI\<locale ID>\. The locale ID 

depends on the language of Microsoft Office selected during installation. For English, the locale 

ID is 1033. 

 Outlook 2003 32-bit - C:\Program Files\Common Files\System\MSMAPI\<locale ID>\ 

 Outlook 2003 64-bit - C:\Program Files\Common Files\System\MSMAPI\<locale ID>\ 

 Outlook 2007 32-bit - C:\Program Files\Microsoft Office\Office12\ 

 Outlook 2007 64-bit - C:\Program Files (x86)\Microsoft Office\Office12\ 

 Outlook 2010 32-bit - C:\Program Files\Microsoft Office\Office14\ 

 Outlook 2010 64-bit - C:\Program Files (x86)\Microsoft Office\Office14\ 

 Office 365 previous version - C:\Program Files\Microsoft Office\root\office15\ 

 Outlook 2013 32-bit - C:\Program Files\Microsoft Office\Office15\ 

 Outlook 2013 64-bit - C:\Program Files (x86)\Microsoft Office\Office15\ 

 Outlook 2016 32-bit - C:\Program Files\Microsoft Office\Office16\ 

 Outlook 2016 64-bit - C:\Program Files (x86)\Microsoft Office\Office16\ 
 Outlook 2019 or Office 365 - C:\Program Files\Microsoft Office\root\office19\
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     3.   REPAIR PROCESS
           Take a backup of the PST file and click the "Repair" button. The actual repair process will start and this will go through

           eight phases as well. This process can take a long time, sometimes even about half an hour, depending on the size of the PST.

            [Caution]: When the repair process is going on, the screen will not respond. But, if the screen doesn't respond for more than

            ten minutes, abort and restart the repair process.

     4.   SUCCESSFUL REPAIR
           If the repair is successful, you'll get a message.

           Relaunch Outlook to check whether normal functioning and performance have been restored. If the process fails, try running

           scanpst.exe again. And if that doesn't work either, look for the third party tools to repair your PST file.

LIMITATIONS OF SCANPST.EXE
Though scanpst.exe is a handy tool to repair corrupt PST files, it has limitations. It can fix only the basic errors to restore the 

PST files. The utility cannot repair severely corrupted PST files or when the system is infected by a virus. Moreover, its recovery 

success rate is average and not known to be reliable in challenging situations. 

The following are a few real-world cases wherein the scanpst.exe utility failed to repair corrupt PST files:

CASE 1 
SCANPST.EXE DOESN’T RESPOND TO REPAIR COMMAND

An Outlook 2007 user reported on TechNet that he couldn't open Outlook Inbox and the client advised using scanpst.exe to fix 

this problem. However, when he attempted repair by using scanpst.exe, the utility failed to respond. It scanned and analyzed 

the corrupt PST file, but, failed to respond (software freeze issue) when the user clicked the Repair button. The PST file was 

reported to be over 9 GB in size.  

CASE 2 

SCANPST.EXE DOESN’T RECOGNIZE THE PST FILE

An Outlook administrator using Outlook 2013 reported on Microsoft Answers forum that one of his archived PST files turned 

corrupt after an abrupt system shutdown. Attempting to repair that archived PST file by using Scanpst.exe didn’t work out; the 

Inbox Repair Tool failed to recognize the PST file. 
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SOFTWARE-BASED SOLUTION FOR PST FILE CORRUPTION
Outlook Inbox Repair Tool (scanpst.exe) is an effective solution to address basic PST file corruption issues, and should serve 

well as the ‘first’ remedial option. But in the context of fast-paced business environments and growing Outlook user base, it’s 

necessary to have a comprehensive and faster solution to fix PST file corruption issues. 

Specialized PST repair software such as Stellar Repair for Outlook can aptly fulfil this need by serving do-it-yourself (DIY) utility 

with comprehensive features and speedy execution. It repairs corrupt PST files of any size and restores mailbox data with 

original integrity, as documented in this case. A Finnish technology company had used this software to repair several oversized 

PSTs and thereby managed to extract all the mailboxes in the set timeframe.

FIXING CORRUPT PST FILES WITH STELLAR REPAIR FOR OUTLOOK
Stellar Repair for Outlook is a comprehensive tool that repairs PST file to recover its mailbox contents safely. This way, it 

ensures there is no data or business loss to your organization due to corruptions or problems in your Outlook PST files.

Features

Stellar Repair for Outlook comes with the following features:

     •    Repairs corrupt PST files and transfers the contents to a new PST file.

     •    The recovered content can be saved in multiple formats such as EML, MSG, RTF, HTML and PDF.

     •    Supports the repair of encrypted and password protected PST files

     •    Option to save and load scan results saved with DAT file extension

     •    Exports repaired PST file in Office 365 format 

     •    Also supports saving in MBOX and DBX formats (Tech Version)

     •    Supports MS Outlook 2019, 2016, 2013, 2010, 2007, 2003, 2002 & 2000

     •    Enables you to view messages in a three-view format.

     •    Gives the option to selectively recover emails

     •    Allows you to search the PST file fast

     •    Repairs emails, calendar entries, contacts, notes, tasks and journals from damaged PST files

     •    Restores formatting from RTF and HTML messages.

     •    Repairs PST files that are larger than 2GB

     •    Repaired file is saved as a new PST file on any disk that is visible to the host operating system.

     •    Option to split and compact the PST File

     •    Comes with an enhanced preview feature.

CASE 3 
SCANPST.EXE STOPS SCANNING THE PST FILE MIDWAY 

An Outlook 2007 user reported on TechNet that he couldn't open Outlook Inbox and the client advised using scanpst.exe to fix 

this problem. However, when he attempted repair by using scanpst.exe, the utility failed to respond. It scanned and analyzed 

the corrupt PST file, but, failed to respond (software freeze issue) when the user clicked the Repair button. The PST file was 

reported to be over 9 GB in size. Another user reported on Microsoft Answers platform that the Inbox Repair Tool remained 

stuck while attempting to repair a corrupt PST file in Outlook 2000. The scanpst.exe utility went through stages 1 to 4 and then 

remained stuck, with a message that indicated an error had interrupted the PST file scanning process.  
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FINDING PST FILES
You can search for PST files in your computer using Stellar Repair for Outlook. You can look for them in drives, folders and 

sub-folders.

FINDING PST FILES IN DRIVES
     •    Open Stellar Repair for Outlook. 
     •    Select PST File for Repair dialog box will appear. 
     •    Click Find button. 
     •    Find PST File dialog box opens. 
     •    Select the drive you want to search for PST files. Click Find.
     •    Click Look in button to particularly select the folder from the drive. 
     •     After the search is finished, a list of PST files found in the selected drive is shown in the Results section. 
     •    Select the file you want to repair and click Repair button to start the repairing process.

FINDING PST FILES IN FOLDERS AND SUBFOLDERS
     •    From Home menu, click on Select Outlook Mailbox icon to open Select PST File for Repair dialog box. 
     •    Click Find button. Find PST File dialog box opens. 
     •    In Find PST File dialog box, select the drive you want to search for PST files. 
     •    Click Look in button and select the folder from which you want to search PST files. Also, if you want to search subfolders
          within that folder, select Search Subfolders checkbox. 
     •    Click Find button.
     •    After the search is finished, list of PST files found in the selected drive is shown in the Results section. 
     •    Select the file you want to repair and click Repair button to start the repairing process.

These features clearly show that Stellar Repair for Outlook tool is your go-to software to work with any kind of corrupted PST 

file. In addition, this tool also addresses the root causes associated with the Outlook PST problem and fixes the same.
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REPAIRING PST FILES
In case if you know your PST file location, the next step is to repair the PST using this tool. Here's how you can do it.

     •    Run Stellar Repair for Outlook software. From the Select PST File for Repair dialog, select the PST files that you want to

           repair.

     •    Click “Repair” to start scanning the selected PST file. 

     •    The time required for scanning depends on the size of the selected PST file. You can stop the scanning process by clicking

          Stop button, which appears during the scanning process.

     •    After completion of the scanning process, Stellar Repair for Outlook application window shows the preview of the PST file. 

The repaired file, along with its original content is shown in a three-pane structure. All repaired folders with number of files in them 

will be listed in the left-pane, under the root node. Click on a folder to view its emails. Click an email to view its content. In addition 

to emails, calendar, contacts, tasks, notes, and journals can also be viewed by clicking on their respective tabs.

SAVING REPAIRED PST DATA TO IMPORT IN OUTLOOK 
     •    To save the repaired PST file, click Save Repaired File icon in Home Menu. Stellar Repair for Outlook dialog box opens. Click

          Browse.

     •    In Browse for Folder dialog box, select the location where you want to save the repaired PST file. Click ‘OK’.

     •    The PST file will be saved at your specified location. You will need to import the repaired PST file to Microsoft Outlook in order

          to use it.

The steps entailed in the above two important processes of locating and repairing files using the software. 
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FINDING AND SAVING A SINGLE MESSAGE
To give you complete control over your PST files and its contents, Stellar Repair for Outlook makes it easy to find and save a single 
message instead of working on the entire contents of the PST file. This option can be particularly important if you're pressed for 
time and want to access only a single message.

The added advantage with this option is you can save the recovered message in any format such as EML, HTML, MSG, RTF and PDF.

ARRANGING THE SCANNED EMAILS
The software allows you to arrange emails based on date, from, to, subject, type, attachment and importance, so you can get to the 
contents you want right away.

IMPORTING PST FILES INTO MICROSOFT OUTLOOK
You can import the repaired PST files to any version of Microsoft Outlook with just a few steps. Also, you can open messages stored 
in any format on Outlook. 

SAVING OF LOG REPORT
With Stellar Repair for Outlook, you can save the entire process in log files, so they can be analyzed later. 

IDEAL FOR ALL USERS
The interface is fairly intuitive and users with any amount of technical skill can navigate through it. This tool is sure to ease the 
pressure on your IT administrators and at the same time, protects the contents of the file without any damage.
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CONCLUSION
PST files have always been an important format for storing emails, calendars, tasks and more, and this trend is likely to continue 

into the future too because most of the organizations in the world today use PST to store their email contents. 

Such ubiquitous use of PST files also necessitates tools that ensure availability and integrity of the data stored in these files. In 

other words, you need the right tools to manage your PST files and to recover data if these files get corrupted due to any reason. 

Scanpst.exe, the in-built tool for PST file recovery, is an effective option for basic corruption cases, especially wherein the PST file 

is relatively smaller (up to 2GB). But, it doesn’t function adequately in the case of severe corruption and when there are multiple 

large PSTs.

A better, more comprehensive solution to tackle this challenge— esp. in fast-paced business environments— is to have a PST 

repair software that can fill in the scenarios wherein scanpst.exe fails (and there are many). 

The Stellar Repair for Outlook software fits this need well because it has evolved through years of innovation to address a variety 

of common and niche issues pertinent to PST files. It blends advanced features with ease-of-use to present a compelling utility for 

any business that uses Outlook. 
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CONTACT DETAILS

Stellar Data Recovery Inc.

48 Bridge Street Metuchen,

New Jersey 08840

United States

call us - 1-877-778-6087

email - support[at]stellarinfo.com

USA Helpline

Sales Queries (Tollfree)+1-877-778-6087

Support Queries+1-732-584-2700

 
UK (Europe) Helpline

Sales & Support Queries+44-203-026-5337

 

 

Stellar Information Technology Pvt. Ltd.

D16, Sector-33, 

Infocity Phase II, 

Gurugram-122001

call us - (0124) 432 6700

email - helpdeskdrs[at]stellarinfo.com

Australia & Asia Pacific

Sales & Support Queries+61-280149899

Netherlands

Sales & Support Queries+31-208-111-188

World Wide Helpline

Sales & Support Queries+91-124-4326-777


